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Preface
Thank you for purchasing the DocuPrint CP105 b.
This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the printer function.
Please read this guide to achieve the best performance from this printer.
This guide assumes you are familiar with computers.
After reading this guide, keep it safe and handy for future reference.

DocuPrint CP105 b User Guide Help

Copyright© 2010 by Fuji Xerox Co., Ltd.

Fuji Xerox Co., Ltd.

October 2010 (Edition 1)

No. ME5046E2-1
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Trademarks and Document Disclaimer
Apple®, Bonjour®, ColorSync®, Macintosh®, and Mac OS® are trademarks of Apple Inc. in the United 
States and/or other countries.
Microsoft®, Windows Vista®, Windows®, and Windows Server® are trademarks of 
Microsoft Corporation in the United States and/or other countries.
All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of 
Xerox Corporation in the U.S. or Fuji Xerox Co., Ltd. 
DocuWorks is a trademark of Fuji Xerox Co., Ltd. 
All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox 
Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

It may be a legal offence to print currency notes, certificates of stocks and securities, or any other documents of 
similar nature, regardless of whether they will be used.

IMPORTANT: 
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 

or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.

5. Decompiling this manual is prohibited.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and 
Foreign Trade of Japan and/or the export control regulations of the United States.
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Types of Manuals

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

User Guide (HTML files) 
(this guide)

Describes how to get ready to print and set various features. It also 
covers the operator panel indicators, troubleshooting tips, and 
maintenance information.

This guide is on the Software Pack CD-ROM.

Operator Panel Guide Describes the icons assigned to the buttons or indicators on the 
operator panel.
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Using This Guide
This section includes:

• "Organization" on page 9
• "Conventions" on page 10
Using This Guide 8



Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and how to turn on the printer.

3 Printer Management Software Describes the software available for the printer.

4 Installing the Print Driver Describes the basic information about how to connect the printer to 
your computer and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Using the Operator Panel Describes the indicators on the operator panel.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace toner cartridges, 
and how to see the printer status.

9 Contacting Fuji Xerox Describes support information.
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Conventions
1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 
• Important information that must be read and followed.

NOTE: 
• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of documents or paper is described in this guide as follows:
, , Long Edge Feed (LEF): Loading the document or paper in portrait orientation.

, , Short Edge Feed (SEF): Loading the document or paper in landscape orientation.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
Using This Guide 10



Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.
This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:
• Any unauthorized alteration including an addition of new functions or connection to external devices 

may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
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Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:
• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not place an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
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Always switch off and unplug the machine when it is not used over weekends or long holidays. 
It may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
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Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 10.55 Kg. 
Otherwise, if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

801 mm

443 mm

200 mm

200 mm

100 mm

100 mm

100 mm

100 mm

100 mm

925 mm
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Others

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 
• Temperature: 10 – 32 °C
• Humidity: 10 – 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

10° 10°

10° 10°

Left

Front

Right

Back

Left

Front

Right

Back
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.
• The product emits smoke or its surface is unusually hot.
• The product emits unusual noise or odor.
• The power cord is cracked or worn down.
• A circuit breaker, fuse or any other safety device is activated.
• Any liquid is spilled into the product.
• The product is soaked in water.
• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not place any of the followings on the product:
• Liquid container such as flower vases or coffee cups
• Metal parts such as staples or clips
• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners, 
or it may catch fire and cause explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.
Safety Notes 16



Do not attempt to remove a paper jammed deeply inside the product, particularly a paper 
wrapped around a Fusing Unit or a heat roller. Otherwise, it may cause injuries or burns. 
Switch off the product promptly and contact your local Fuji Xerox representative.

Ventilate well during extended operation or mass copying. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room. 

Provide proper ventilation to ensure the comfortable and safe environment.
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Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. 
It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill 
a large volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it 
out, rinse mouth with water, drink water and consult a physician immediately.

When replacing toner cartridges, be careful not to spill the toner. In case of any toner spills, 
avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes 
until irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
Safety Notes 18



Warning and Caution Labels
Always follow all warning instructions marked on or supplied with this product.
To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" 
or "High Voltage" marks on.
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Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 

containers. Return them to your local Fuji Xerox representative.
Environment 20



Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (CB)
This product is certified by the following agency using the safety standards listed.

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. This 
product generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
product does cause harmful interference to radio or television reception, which can be 
determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between this product and the receiver.
• Connect this product into an outlet on a circuit different from that to which the receiver is 

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.

Agency Standard

TUV-Rh IEC60950-1:ed. 2
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Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency
• Banknotes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
Illegal Copies and Printouts 22



Product Features
This chapter describes the product features and indicates their links.

2 Sided Print (Manual)

2 Sided Print is to print two or more pages on 
the front and back sides of a single sheet of 
paper manually. This feature allows you to 
reduce the paper consumption.

For more information, see "Manual Duplex 
Printing (Windows Print Driver Only)" on 
page 84.

Multiple-Up Print

Multiple-Up enables you to print multiple pages 
on a single sheet of paper. This feature allows 
you to reduce the paper consumption.

For more information, see the print driver's 
Help.
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may 
change without prior notice.

Items Description
Product Code DocuPrint CP105 b 220V: TL300593/TL300623/TL300594

DocuPrint CP105 b 220V CHINA: TL300592

DocuPrint CP105 b 110V: TL300595

Type Desktop

Printing method LED Xerography

IMPORTANT: 
• LED + LED electrophotographic system

Fusing system Thermal fusing system using a belt

Warm-up Time Less than 25 seconds (after powering on at 22 °C temperature) 

Continuous print speed*1 A4 : When plain paper fed is from the multipurpose feeder

Color 1 Sided*2: 10 sheets/min

Monochrome 1 Sided: 12 sheets/min

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, 

and printing conditions.
*2 When continuously printing a single document of A4 .

First print Color 29 seconds (A4 /Fed from the multipurpose feeder)

Monochrome 24 seconds (A4 /Fed from the multipurpose feeder)

IMPORTANT: 
• Measurements based on Fuji Xerox test pattern. Time from printer 

startup until output of the first page is complete. Except the time 
when the printer controller receives or processes the print data.

Resolution Data Processing Resolution:
600 × 600 dpi

Output Resolution:
1200 × 2400 dpi

Tone/Color 256 tones/color (16.7 million colors)
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Paper Size Multipurpose feeder:

A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), 
Executive, #10 Env, Monarch, DL, C5, Postcard (100 × 148 mm), 
Postcard (148 × 200 mm), Yougata 2, Yougata 3, Yougata 4, Younaga 
3, Nagagata 3, Custom Size (Width: 76.2 – 215.9 mm, Length: 127 – 
355.6 mm)

Image loss: 4.1 mm from the top, bottom, left, and right edges

Paper Type Plain, Bond, Lightweight Cardstock, Japanese Glossy Cardstock, 
Lightweight Glossy Cardstock, Recycled, Labels, Envelope, 
Postcard, Letterhead, Pre-Printed, Hole Punched, Colored, Special, 
Custom Type

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)
• Use only the recommended paper. Using paper other than that 

recommended for the printer can cause printing problems. Do not 
use special ink jet paper. 

• Note that poor printing quality due to paper-related printing 
problems can occur when using the printer in an environment that 
is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that 
already has been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have 
adhesive applied.

• The type of paper being used and environmental conditions can 
affect printing quality. Because of this, it is recommended that you 
test print and confirm proper print quality before using the printer.

Paper capacity Standard:
Multipurpose feeder: 150 sheets

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)

Output tray capacity Standard: approximately 100 sheets (face down)

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)

2-sided Printing Feature Standard (Manual)

CPU ARM9 192MHz 

Memory capacity Standard: 64 MB (Onboard)

IMPORTANT: 
• The above memory capacity does not guarantee print quality 

depending on the type and content of print data. 

Hard disk —

Page Description Language — (Host-based)

Items Description
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Supported OS*1 Windows® XP, Windows® XP x64 Edition, Windows Vista®, Windows 
Vista® x64 Edition, Windows Server® 2003, Windows Server® 2003 
x64 Edition, Windows Server® 2008, Windows Server® 2008 x64 
Edition, Windows Server® 2008 R2 x64 Edition, Windows® 7, 
Windows® 7 x64 Edition, Mac OS®*2

IMPORTANT: 
*1 For the latest information about the supported operating systems, contact 

our Customer Support Center or your dealer.
*2 Mac OS® X 10.3.9 – 10.6 are supported.

Interface Standard: USB 1.1/2.0 (Hi-Speed)

Power AC 100 – 127 V ± 10%; 10.5 A; both 50/60 Hz ± 3 Hz

AC 220 – 240 V ± 10%; 4.5 A; both 50/60 Hz ± 3 Hz

IMPORTANT: 
• Power outlets that provide the above power level is 

recommended. Maximum machine measured current: 
7.0 A (AC 100 – 127 V)/4.0 A (AC 220 – 240 V)

Operating noise

(main unit only)

During operation: 
Color: 6.26 B; 46 dB (A)
Monochrome: 6.26 B; 47 dB (A)

During stand-by: 4.3 B; 20 dB (A)

IMPORTANT: 
• Measurements based on ISO7779

Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power consumption Maximum: 285 W, During Mode 2 of Power Saver Mode: 5 W or less

Average: 
During standby: 66 W, 
During continuous color printing: 285 W, 
During continuous monochrome printing: 285 W

IMPORTANT: 
• Mode 1 of Power Saver Mode: 11 W average

(The printer does not use electricity when the power is switched 
off even with the power cord is plugged in.)

Dimensions (main unit only) 394 (W) × 300 (D)*1 × 225 (H) mm

IMPORTANT: 
*1 When the front cover is closed.

Items Description
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Weight Main Unit: 10.55 kg (main unit only, including toner cartridges)

Usage Environment During Use: Temperature: 10 – 32 °C; Humidity: 10 – 85% (except 
malfunctions due to dew condensation)

Non-Use: Temperature: -10 – 40 °C; Humidity: 5 – 85% (except 
malfunctions due to dew condensation)

IMPORTANT: 
• Until the conditions (temperature and humidity) inside the printer 

become acclimated to the installation environment, certain 
qualities of the paper can cause poor printing. 

Items Description
Specifications 28



2
Basic Operation

This chapter includes:
• "Main Components" on page 30
• "Turning On the Printer" on page 35
• "Printing a Panel Settings Page" on page 36
• "Power Saver Mode" on page 39
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Main Components
This section provides an overview of your DocuPrint CP105 b.
This section includes:

• "Front View" on page 31
• "Rear View" on page 32
• "Operator Panel" on page 33
Basic Operation 30



Front View

1 Operator Panel 2 Center Output Tray

3 Output Tray Extension 4 Print Head Cleaning Rod

5 Toner Access Cover 6 Power Switch

7 Paper Width Guides 8 Multipurpose feeder (MPF)

9 Front Cover 10 Slide Bar

11 Length Guide 12 Paper Cover

1 2 3 4

12 11 10 9 8 7 6 5
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Rear View

1 Power Connector 2 Rear Cover Handle

3 USB Port 4 Rear Door

5 Transfer Roller 6 Paper Chute

7 Paper Feed Roller 8 Transfer Belt

9 Levers

8
7
6

9

5

1 2

4

3
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Operator Panel
The operator panel has two buttons and several indicators that show the status of the printer.

1 Toner Indicators
• Indicates that the toner is low or empty, or toner error occurred.

2  (Energy Saver) Indicator
• Indicates that the printer is in the Power Saver Mode.

3  (Jam) Indicator
• Indicates that a paper jam occurred.

4  (Cancel Job) Button
• Press this button to cancel a job or clear an error.

5  (Start) Button/Indicator
• Press this button to start 2 sided printing after loading paper.
• Press and hold this button to print the report pages.

6  (Error) Indicator 
• Indicates that an error occurred.

7  (Load Paper) Indicator 
• Indicates that no paper is loaded or the wrong size of paper is loaded.

8  (Ready/Data) Indicator
• Indicates the printer status, such as receiving and printing data.

The indicators provide information on the status of the printer and help you locate each problem.

KC
YM

1

2
3
4

5
6

7
8
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Indicator Status Condition
Toner Orange on The specified toner is low or not installed when genuine toner 

cartridges are used (Non Genuine Toner is set to off at the 
Printer Setting Utility).

All toner indicators light up when the printer is in the non-
genuine toner mode (Non Genuine Toner is set to On at the 
Printer Setting Utility).

Orange blinks The specified toner cartridge is empty or invalid when genuine 
toner cartridges are used (Non Genuine Toner is set to off at 
the Printer Setting Utility).

Energy Saver Green on The printer is in the Power Saver Mode.

Green blinks The printer is canceling.

Jam Orange blinks A paper jam occurred.

Cancel Job - To cancel the current job or clear the error, press the  
(Cancel Job) button.

Start Green blinks To continue printing, press the  (Start) button.

Error Orange on An error occurred.

Orange blinks A fatal error occurred.

Load Paper Orange blinks No paper is loaded or the wrong size of paper is loaded.

Ready/Data Green on The printer is ready to print.

Green blinks The printer is processing, printing or canceling.
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Turning On the Printer
IMPORTANT: 
• Do not use extension cords or power strips.
• The printer should not be connected to an uninterruptible power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer (see "Rear View" on 
page 32).

2 Connect the other end of the cord to the power source.

3 Turn on the printer.
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Printing a Panel Settings Page
The Panel Settings page shows current settings for the system and maintenance. 
Basic Operation 36



The Operator Panel
1 Press and hold the  (Start) button when the  (Ready/Data) indicator lights (ready status) 

until the  (Ready/Data) indicator blinks. 
The Panel Settings page, Printer Settings page, and Error History Report are printed.
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The Printer Setting Utility
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Information Pages from the list at the left side of the page.
The Information Pages page is displayed.

4 Click the Panel Settings button.
The Panel Settings page is printed.
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Power Saver Mode
The printer has a power saving feature which reduces power consumption during periods of inactivity. 
This feature operates in two modes: the Mode 1 and Mode 2. The power consumption of the printer in 
Mode 2 is lower than in Mode 1. As delivered, the printer switches to the Mode 1 five minutes after the 
last print job is printed. The printer then switches to the Mode 2 after another six minutes of inactivity. 
When the printer is in the Mode 1, all lamps on the operator panel except for the  (Energy Saver) 
indicator and the indicator announcing that a problem occurs go out. In the Mode 2, all lamps on the 
operator panel except for the  (Energy Saver) indicator go out.
The factory default settings of five minutes (Mode 1) and six minutes (Mode 2) are changeable within 
the range of 5 to 30 minutes (Mode 1) and 1 to 6 minutes (Mode 2). The printer returns to the ready-to-
print state in about 25 seconds when re-activated.
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Setting the Time for the Power Saver Mode
You can specify the time for the Power Saver Mode. The printer switches to the Power Saver Mode 
after the specified time.
The following procedure uses Microsoft Windows XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select System Settings from the list at the left side of the page.
The System Settings page is displayed.

4 Specify the time for Mode 1 and Mode 2 for Power Saver Mode.

5 Click the Apply New Settings button to take effect.
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Exiting the Power Saver Mode
The printer automatically exits the Power Saver Mode when it receives a print job from a computer. To 
manually exit the Power Saver Mode, press any button on the operator panel.

NOTE: 
• Opening and closing the rear door will cause the printer to exit the Mode 1.
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3
Printer Management Software

Use the Software Pack CD-ROM that shipped with your printer to install a combination of software 
programs, depending on your operating system.
This chapter includes:

• "Print Driver" on page 44
• "Printer Setting Utility (Windows Only)" on page 45
• "SimpleMonitor (Windows Only)" on page 46
• "Launcher (Windows Only)" on page 47
• "User Setup Disk Creating Tool (Windows Only)" on page 48
• "Status Monitor Widget (Mac OS X Only)" on page 49
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Print Driver
To access all of your printer’s features, install the print driver from the Software Pack CD-ROM.
The Print driver enables your computer and printer to communicate and provides access to your 
printer features.

See also: 
• "Installing Print Driver on Computers Running Windows" on page 55
• "Installing Print Driver on Computers Running Mac OS X" on page 58
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Printer Setting Utility (Windows Only)
The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the 
system settings by using the Printer Setting Utility.
The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and 
Diagnosis tabs.
The Printer Setting Utility is installed with your Fuji Xerox print driver.
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SimpleMonitor (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Select Printer window appears, which displays the 
printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 
Status Settings button: Displays the Status Settings screen and allows you to modify the 
SimpleMonitor settings.
Click the name of the desired printer listed on the Select Printer window. The Status Monitor window 
appears.
The Status Monitor window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.
By default, the Status Monitor window launches automatically when printing starts. You can specify 
the conditions for starting the Status Monitor window in Auto start setup.

To change the pop-up settings for the Status Monitor window:
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click Status Settings.
The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.

You can also check the toner level of your printer and the job information on the Status Monitor 
window.
The SimpleMonitor is installed with your Fuji Xerox print driver.
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Launcher (Windows Only)
Using the Launcher window, you can open the Status Window, Printer Setting Utility, and 
Troubleshooting.
To use the Launcher, select to install the Launcher when you install the Fuji Xerox print driver.
The following procedure uses Windows XP as an example.
To open the Launcher window:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
Launcher.
The Launcher dialog box appears.

2 The Launcher window provides three buttons; Status Window, Printer Setting Utility, and 
Troubleshooting.
To exit, click the X button at the top-right of the window.

For details, click the Help button/icon of each application.

Status Window Click to open the Status Monitor window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 46

Printer Setting Utility Click to open the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 45

Troubleshooting Click to open the Troubleshooting guide, which allows you to resolve 
issues by yourself.
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User Setup Disk Creating Tool (Windows Only)
The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on 
the Software Pack CD-ROM and the print driver located on the Software Pack CD-ROM are used to 
create driver installation packages that contain custom driver settings. A driver installation package 
can contain a group of saved print driver settings and other data for things such as:

• Print orientation and Multiple-UP (document settings) 
• Watermarks 

If you want to install the print driver with the same settings on multiple computers running on the same 
operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup 
disk that you have created will reduce the amount of work required when installing the print driver.

• Install the DocuPrint CP105 b print driver in the computer on which the setup disk is to be 
created.

• The setup disk can only be used on the operating system on which the disk was created or 
computers running the same operating system. Create a separate setup disk for each of the 
operating systems.
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Status Monitor Widget (Mac OS X Only)
Status Monitor Widget is a printer utility that promotes efficient use of the printer through the exchange 
of information between the Mac OS® X and the printer.
You can install the Status Monitor Widget from the Software Pack CD-ROM. For information on the 
installation, see "Installing the Software" on page 60.
To open the Status Monitor Widget:
Click the Dashboard icon in the dock to launch Dashboard.

Status Monitor window appears.

1 Printer Status Message Area
Displays a message of the current printer status.

NOTE: 
• The Status Monitor Widget automatically obtains the printer information at the updated interval that can 

be specified in preferences. Also, the printer status is refreshed when you launch the Dashboard or close 
the preferences.

• If you receive no response from the printer or the printer is processing a job using a USB connection, 
"Cannot get printer information." is displayed.

2 Printer Status Image Area
Displays the image of printer condition. 

• Estimated Toner Level image
Displays the estimated toner level of each color if the printer is functioning properly.

NOTE: 
• If the utility does not receive a response from the printer, the unknown toner image appears.

1

2

3

Less than 29% Less than 9% Unknown
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• Printer error image
Displays an indication image when an error occurs.

3 Info (i) button
Click this button to open preferences.

NOTE: 
• The info (i) button appears on the lower-right corner of the window when the cursor is over the Status 

Monitor window.

An error has occurred and the printer requires your attention to correct a problem.

An error has occurred and the printer cannot be used.

An unknown error has occurred and the printer cannot be used.

Printer Displays a list of available printer names in the drop-down list. The 
first printer displayed in this list is set as default.

Status Update Interval You can specify the update interval of the printer status. By default, it 
is set to obtain the printer information every 10 seconds. The range 
varies between 0 and 600.

done button Click this button to return to the Status Monitor window.
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4
Installing the Print Driver

This chapter includes:
• "Connecting Your Printer" on page 52
• "Installing Print Driver on Computers Running Windows" on page 55
• "Installing Print Driver on Computers Running Mac OS X" on page 58
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Connecting Your Printer
Your DocuPrint CP105 b interconnection cable must meet the following requirement:

Connection Type Connection Specification
USB USB 1.1/2.0 compatible

1 USB Port

1
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Connecting Printer to Computer
Connect the printer via USB. A USB connection is a direct connection and is not used for networking. 
The available feature is shown in the following table.

Connection Type Available Feature
USB You can instruct print jobs from a computer.
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USB Connection
A local printer is a printer which is directly attached to your computer using the USB cable.
The following operating systems support USB connection:

• Microsoft® Windows® XP
• Windows XP 64-bit Edition
• Windows Server® 2003
• Windows Server 2003 x64 Edition
• Windows Server 2008
• Windows Server 2008 64-bit Edition
• Windows Server 2008 R2
• Windows Vista®

• Windows Vista 64-bit Edition
• Windows 7
• Windows 7 64-bit Edition
• Mac OS® X 10.3.9/10.4.11/10.5.8 -10.6

To attach the printer to a computer:

1 Ensure that the printer, computer, and any other attached devices are turned off and unplugged 
from the power source/outlet.

2 Connect the smaller USB connector into the USB port at the back of the printer and the other end 
of the cable into a USB port of the computer.

NOTE: 
• Do not connect the printer USB cable to the USB connector available on the keyboard.

USB port
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Installing Print Driver on Computers Running 
Windows
This section includes:

• "Inserting the Software Pack CD-ROM" on page 56
• "USB Connection Setup" on page 57
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Inserting the Software Pack CD-ROM
1 Insert the Software Pack CD-ROM into your computer to start Easy Install Navi.

NOTE: 
• If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for 

Windows Vista and Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then 
enter D:\setup.exe (where D is the drive letter of your CD), and then click OK.
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USB Connection Setup
The following procedure uses Windows XP as an example.

• When the Printer is Connected to Computer With a USB Cable

1 Turn on the printer.

NOTE: 
• If Found New Hardware Wizard appears, click Cancel at this time.

2 Click Installing Drivers and Software.

3 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

4 Follow the on-screen instructions.
The Plug and Play installation starts and the installation software proceeds to the next page 
automatically.

5 Click Finish to exit the wizard when the "Congratulations!" screen appears. If necessary, click 
Print Test Page to print a test page.

• When the Printer is not Connected to Computer With a USB Cable

1 Turn off the printer.

2 Click Installing Drivers and Software.

3 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

4 Follow the on-screen instructions to connect the computer and the printer with the USB cable, 
and then turn on the printer.

5 Click Finish to exit the wizard.

6 Proceed the Plug and Play installation.
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Installing Print Driver on Computers Running Mac 
OS X
This section includes:

• "Installing the Driver" on page 59
• "Installing the Software" on page 60
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Installing the Driver
The following procedure uses Mac OS X 10.6 as an example.

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CP205 CP105 Print Installer icon.

3 Click Continue on the Introduction screen.

4 Select a language for the Software License Agreement.

5 After reading the Software License Agreement, click Continue.

6 If you agree to the terms of the Software License Agreement, click Agree to continue the 
installation process.

7 Click Install to perform the standard installation. 

8 Enter the administrator's name and password, and then click OK.

9 Click Close to complete installation.
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Installing the Software
The following procedure uses Mac OS X 10.6 as an example.

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CP105 Status Monitor Installer icon.

3 Click Continue on the Introduction screen.

4 Select a language for the Software License Agreement.

5 After reading the Software License Agreement, click Continue.

6 If you agree to the terms of the Software License Agreement, click Agree to continue the 
installation process.

7 Click Install to perform the standard installation. 

8 Enter the administrator's name and password, and then click OK.

9 Click Close to complete installation.

Adding a Printer on Mac OS X 10.5.8/10.6 or Later Version(s)

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Display System Preferences, and then click Print & Fax.

5 Confirm your USB printer is added to Print & Fax in System Preferences.
If your USB printer is not displayed, execute the following procedures.

6 Click the plus (+) sign, and then click Default.

7 Select the printer connected via USB from the Printer Name list.
Name, Location, and Print Using are automatically entered.

8 Click Add.
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Adding a Printer on Mac OS X 10.4.11

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

5 Confirm your USB printer is added to Printer List.
If your USB printer is not displayed, execute the following procedures.

6 Click Add.

7 Click Default Browser in the Printer Browser dialog box.

8 Select the printer connected via USB from the Printer Name list.
Name, Location and Print Using are automatically entered.

9 Click Add.

Adding a Printer on Mac OS X 10.3.9

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

5 Confirm your USB printer is added to Printer List.
If your USB printer is not displayed, execute the following procedures.

6 Click Add.

7 Select USB from the menu.

8 Select the printer from the Product list.
Printer Model is automatically selected.

9 Click Add.
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5
Printing Basics

This chapter includes:
• "About Print Media" on page 64
• "Supported Print Media" on page 68
• "Loading Print Media" on page 72
• "Printing" on page 88
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About Print Media
This section includes:

• "Print Media Usage Guidelines" on page 65
• "Print Media That Can Damage Your Printer" on page 66
• "Print Media Storage Guidelines" on page 67

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failure. To achieve the best performance from your printer, we recommend you to use only the 
paper described in this section.
When using paper other than that recommended, contact the Fuji Xerox local representative office or 
an authorised dealer.
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Print Media Usage Guidelines
The printer tray accommodates most sizes and types of paper and other specialty media. Follow these 
guidelines when loading paper and media in the tray:

• Fan paper or other specialty media before loading in the multipurpose feeder (MPF).
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 

release strips.
• Print all envelopes single-sided only. 
• Some wrinkling and embossing may occur when printing envelopes.
• Do not overload the paper tray. Do not load print media above the fill line on the inside of the 

paper width guides.
• Adjust the paper width guides to fit the paper size.
• If excessive jams occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 75
• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 79
• "Printing on Custom Size Paper" on page 96

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can 
cause poor output quality, increased paper jams, or damage to your printer.
Unacceptable media includes:

• Rough or porous media
• Plastic media
• Paper that has been folded or wrinkled
• Paper with staples
• Envelopes with windows or metal clasps
• Padded envelopes
• Non-laser glossy or coated paper
• Perforated media

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.
• Avoid attics, kitchens, garages, and basements for storing print media. 
• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where print media is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags. 
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of this printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 
• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the 

Fuji Xerox local representative office or an authorized dealer.
Printing Basics 68



Usable Print Media
The types of print media that can be used on this printer are as follows:
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Multipurpose Feeder (MPF)

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Legal SEF (8.5 × 14 inches)

Folio SEF (8.5 × 13 inches)

Executive SEF (7.25 × 10.5 inches)

C5 SEF (162 × 229 mm)

Monarch SEF (3.875 × 7.5 inches)

Monarch LEF (7.5 × 3.875 inches)*1

# 10 Env SEF (4.125 × 9.5 inches)

DL SEF (110 × 220 mm)

DL LEF (220 × 110 mm)*1

Yougata 2 SEF (114 × 162 mm)

Yougata 2 LEF (162 × 114 mm)*1

Yougata 3 SEF (98 × 148 mm)

Yougata 3 LEF (148 × 98 mm)*1

Yougata 4 SEF (105 × 235 mm)

Younaga 3 SEF (120 × 235 mm)

Nagagata 3 SEF (120 × 235 mm)

Postcard SEF (100 × 148 mm)

Postcard SEF (148 × 200 mm)

Custom Size:
Width: 76.2–215.9 mm (3–8.5 inches)*2

Length: 127–355.6 mm (5 –14 inches)*3

Paper Type (Weight) Plain

Bond

Lightweight Cardstock

Japanese Glossy Cardstock

Lightweight Glossy Cardstock

Labels

Envelope

Recycled

Postcard

Letterhead

Pre-Printed

Hole Punched

Colored

Special

Custom Type
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NOTE: 
• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-

edge feed.
• Use only laser print media. Do not use ink jet paper in this printer.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 75
• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 79
• "Loading Postcard in the Multipurpose Feeder (MPF)" on page 82
• "Loading Letterhead in the Multipurpose Feeder (MPF)" on page 83

Printing on print media that differs from the paper size or paper type selected on the print driver may 
lead to paper jams. To ensure that printing is correctly done, select the correct paper size and paper 
type.

Loading Capacity 150 sheets of standard paper
*1 Monarch, DL, Yougata 2, and Yougata 3 envelopes can be supported by LEF with their flap open.
*2 The maximum width is 220 mm for DL LEF.
*3 The minimum length is 3.875 inches for Monarch LEF, 110 mm for DL LEF, 114 mm for Yougata 2 LEF, 

and 98 mm for Yougata 3 LEF.
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Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.
Before loading print media, identify the recommended print side of the print media. This information is 
usually on the print media package.

NOTE: 
• After loading paper in the feeder, specify the same paper type on the print driver.
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Capacity
Multipurpose feeder (MPF) can hold:

• 150 sheets of standard paper
• 16.2 mm (0.64 inches) of thick paper
• One sheet of coated paper
• 16.2 mm (0.64 inches) of post cards
• Five envelopes
• 16.2 mm (0.64 inches) of labels
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Print Media Dimensions
The MPF accepts print media within the following dimensions: 

• Width: 76.2 –215.9 mm (3.00–8.50 inches)
• Length: 127–355.6 mm (5.00–14.00 inches)

NOTE: 
• The maximum width is 220 mm for DL LEF.
• The minimum length is 3.875 inches for Monarch LEF, 110 mm for DL LEF, 114 mm for Yougata 2 LEF, and 98 

mm for Yougata 3 LEF.
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Loading Print Media in the Multipurpose Feeder (MPF)
NOTE: 
• To avoid paper jams, do not remove the paper cover while printing is in progress.
• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

NOTE: 
• When you use the MPF for the first time, open the front cover by pulling out the instruction sheet.

2 Pull the paper cover out.

NOTE: 
• When you use the MPF for the first time, remove the instruction sheet attached to the paper cover with 

adhesive tape.
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3 Pull the slide bar forward until it stops.

4 Pull the length guide forward until it stops.

5 Adjust the paper width guides to their maximum width.

6 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.
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7 Load print media on the MPF with the top edge first and with the recommended print side facing 
up.

8 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.

9 Slide the length guide towards the printer until it touches the print media.
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NOTE: 
• Depending on the size of print media, first slide the slide bar backward until it stops, and then pinch the 

length guide and slide it backward until it touches print media.

10 Insert the paper cover into the printer and then align the paper cover to the marking on the MPF.
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11 Open the output tray extension.

12 Select the paper type from the print driver if the loaded print media is not standard plain paper. If 
a user-specified print media is loaded in the MPF, you must specify the paper size setting by 
using the print driver.

NOTE: 
• For more information about setting the paper size and type on the print driver, refer to the online Help 

provided for the print driver.

NOTE: 
• For standard-size paper, adjust the guides first and then set paper.

Loading Envelope in the Multipurpose Feeder (MPF)
NOTE: 
• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 

print image will be rotated 180 degrees.
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• When Loading # 10, DL, Monarch, Yougata 2/3/4, or Younaga 3
Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned 
to the right.

To prevent DL, Monarch, Yougata 2, and Yougata 3 from being wrinkled, they are recommended to be 
loaded with the print-side facing up, flap opened, and facing you.

NOTE: 
• When you load the envelopes in the long-edge feed (LEF) orientation, be sure to specify the landscape 

orientation on the print driver.
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• When Loading C5 or Nagagata 3
Load envelopes with the side to be printed on facing up, flap opened, and facing you.

IMPORTANT: 
• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 

printer.

NOTE: 
• If you do not load envelopes in the MPF right after they have been removed from the packaging, they may 

bulge. To avoid jams, flatten them as shown below when loading them in the MPF.

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.
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• To confirm the correct orientation of each print media such as envelopes, see the instruction on the 
Envelope/Paper Setup Navigator on the print driver.

Loading Postcard in the Multipurpose Feeder (MPF)
NOTE: 
• When you print on postcards, be sure to specify the postcard setting on the print driver to get the optimum 

print result.

• When Loading Postcard
Load the postcard with the side to be printed on facing up, and the top edge of the postcard in first.
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• When Loading W-Postcard
Load the w-postcard with the side to be printed on facing up, and the left edge of the w-postcard in 
first.

NOTE: 
• To confirm the correct orientation of each print media such as postcards, see the instruction on the 

Envelope/Paper Setup Navigator on the print driver.

Loading Letterhead in the Multipurpose Feeder (MPF)
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead 
enters the printer first.
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Manual Duplex Printing (Windows Print Driver Only)
This section includes:

• "Operations on Your Computer" on page 85
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 86

NOTE: 
• When printing on curled paper, straighten the paper and then insert it into the feeder.

When you start manual duplex printing, the instruction window appears. Note that the window cannot 
be reopened once it is closed. Do not close the window until duplex printing is complete.
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Operations on Your Computer
The following procedure uses Microsoft® Windows® XP WordPad as an example.

NOTE: 
• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 

software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer from the Select Printer list box, and then click Preferences.

3 The Paper / Output tab appears.
From 2 Sided Print, select either 2 Sided, Flip on Short Edge or 2 Sided Print to define the 
way 2-sided print pages are bound. 

4 From Paper Size, select the size of the document to be printed.

5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

IMPORTANT: 
• When you start manual duplex printing, the instruction window appears. Note that the window cannot be 

reopened once it is closed. Do not close the window until duplex printing is complete.

3

4

5
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Loading Print Media in the Multipurpose Feeder (MPF)

1 First print the even pages (rear sides).
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.

The  (Start) indicator blinks and the  (Ready/Data) indicator lights when the even pages 
finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 
• Warped or curled prints can cause paper jams. Straighten them before setting them.

3 Stack the prints and set them as they are (with the blank side facing up) into the MPF.

4 Press the  (Start) button. 
Pages are printed in the order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 
5 (rear of page 6).

NOTE: 
• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print 
job is complete.
Before printing a document, ensure that the output tray extension is opened.
87 Printing Basics



Printing
This section covers how to print certain lists of information from your printer and how to cancel a job.
This section includes:

• "Sending a Job to Print" on page 89
• "Canceling a Print Job" on page 90
• "Selecting Printing Options" on page 91
• "Printing Custom Size Paper" on page 96
• "Checking Status of Print Data" on page 98
• "Printing a Report Page" on page 99
• "Printer Settings" on page 100
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Sending a Job to Print
Install the print driver to use all the features of the printer. When you choose Print from a software 
program, a window representing the print driver opens. Select the appropriate settings for the specific 
job you are sending to print. Print settings selected from the driver have precedence over the default 
menu settings selected from the Printer Setting Utility.
You may need to click Preferences from the initial Print dialog box to see all the available system 
settings you can change. If you are not familiar with a feature in the print driver window, open the 
online Help for more information.
To print a job from a typical Windows application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed 
(such as the pages you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Quantity, Paper Size, or 
Feed Orientation, click Preferences.
The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.
This section includes:

• "Canceling From the Operator Panel" on page 90
• "Canceling a Job From the Computer Running Windows" on page 90

Canceling From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Cancel Job) button.

NOTE: 
• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 
A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

• Canceling a Job From the Desktop

1 Minimize all programs to reveal the desktop.
Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server® 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printer (for Windows Server 2008).

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.
A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 91
• "Selecting Options for an Individual Job (Windows)" on page 92
• "Selecting Options for an Individual Job (Mac OS X)" on page 94

Selecting Printing Preferences (Windows)
Printer preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex printing for most jobs, set this option in printer settings.
To select printer preferences:

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printer (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing Preferences.
The FX DocuPrint CP105 b Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 
• For more information about Windows print driver options, click Help on the print driver tab to view the online 

Help.
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Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting in the driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select the DocuPrint CP105 b and click Preferences to open the print driver.

3 Make selections on the driver tabs. See the following table for specific printing options.

NOTE: 
• In Windows, you can save current printing options with a distinctive name and apply them to other print 

jobs. Make selections on the Paper / Output, Image Options, Layout, Watermarks, or Advanced 
Settings tab, and then click Save under Saved Settings on the Paper / Output tab. Click Help for more 
information.

4 Click OK to save your selections.

5 Print the job.
See the following table for specific printing options:

Printing Options for Windows
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Operating System Driver Tab Printing Options
Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Paper / Output tab • Saved Settings
• 2 Sided Print
• Output Color
• Quantity
• Collated
• Paper Summary
• Paper Size
• Paper Type
• Feed Orientation
• Envelope/Paper Setup Navigator
• Printer Status
• Defaults

Image Options tab • Output Color
• Output Recognition
• Image Adjustment Mode
• Image Types
• Image Auto Correction
• Image Settings
• Color Balance
• Profile Settings
• Defaults

Layout tab • Image Orientation
• Multiple-Up
• Booklet / Poster / Mixed Document / Rotation
• Fit to New Paper Size
• Specify Zoom
• Image Shift / Print Position
• Defaults

Windows XP, Windows 
Server 2003, Windows 
Vista, Windows Server 
2008, or Windows 7

Watermarks tab • Watermarks
– New Watermark
– Edit Watermark
– Delete Watermark
– Apply to First Page Only

• Annotation
• Defaults

Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Advanced Settings tab • Skip Blank Pages
• Draft Mode
• Other Settings (Graphics Settings)

– Items
– Settings for
– Paper Tray Selection Method

• About
• Defaults
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select the DocuPrint CP105 b from Printer.

3 Select the desired printing options from the menus and drop-down lists that are displayed.

NOTE: 
• In Mac OS® X, click Save As on the Presets menu screen to save the current printer settings. You can 

create multiple presets and save each with its own distinctive name and printer settings. To print jobs 
using specific printer settings, click the applicable saved preset in the Presets list.

4 Click Print to print the job.
Mac OS X Print Driver Printing Options:
The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options
• Copies
• Collated
• Pages
• Paper Size
• Orientation

Layout • Pages per Sheet
• Layout Direction
• Border
• Two-Sided

Color Matching • ColorSync
• Vendor Matching

Paper Handling • Pages to Print
• Page Order
• Destination Paper Size

Cover Page • Print Cover Page
• Cover Page Type
• Billing Info

Scheduler • Print Document
• Priority

Job Accounting • Account Mode

Image Settings • Brightness
• Contrast
• Chroma
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Printer Features • Basic
– Output Color
– Paper Type

• Detailed Settings 1
– Image Type
– Image Rotation (180deg)
– Skip Blank Pages
– Draft Mode
– Trapping
– Image Enhancement

• Detailed Settings 2
– Sharpness Adjustment
– Screen

• Color Balance (C/M/Y/K)
– Low Density
– Medium Density
– High Density

Summary

Item Printing Options
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.
The way to load custom size paper in the MPF is the same as the one to load standard size paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 75

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 
• When setting the paper size on the print driver, be sure to specify the same size as the actual print media 

used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a 
bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows XP as an example.
For Windows XP or later, an administrator’s password only allows users with administrator rights to 
change the settings. Users without the rights of administrator can only view the contents.

1 Click start → Printers and Faxes.

2 Right-click the icon for your printer, and then select Properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Settings for. You can specify the 
values either by entering them directly or using the up arrow and down arrow buttons. The length 
of the short edge cannot be longer than the long edge, even if it is within the specified range. The 
length of the long edge cannot be shorter than the short edge, even if it is within the specified 
range.

7 To assign a paper name, select the Name Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.

Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.
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• Using the Windows Print Driver
This section explains the procedure using Windows XP WordPad as an example.

NOTE: 
• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 

software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer as the printer to be used and click Preferences.

3 Select the Paper / Output tab.

4 Select the size of the original document from Paper Size.

5 Select the appropriate paper type from Paper Type.

6 Click the Layout tab.

7 From Fit to New Paper Size, select the custom size you defined. If you have selected the 
custom size from Paper Size in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select the printer as the printer to be used from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.
A newly created setting "Untitled" is displayed in the list.

5 Double-click "Untitled" and enter a name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Click Print to start printing.
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Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 98

Checking Status (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Select Printer window appears, which displays the 
printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 
Status Settings button: Displays the Status Settings screen and allows you to modify the 
SimpleMonitor settings.
Click the name of the desired printer listed on the Select Printer window. The Status Monitor window 
appears. You can check the printer status and print job status.
For more information about SimpleMonitor, see Help. The following procedure uses Windows XP as 
an example:

1 Click start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 46
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Printing a Report Page
To confirm your printer settings, print a report page.
This section describes two methods of printing a report page.

Printing a Printer Settings Page
To verify detailed printer settings, print a Printer Settings page.

The Operator Panel

1 Press and hold the  (Start) button when the  (Ready/Data) indicator lights (ready status) 
until the  (Ready/Data) indicator blinks. 
The Printer Settings page, Panel Settings page, and Error History Report are printed.

The Printer Setting Utility
The following procedure uses Windows XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Information Pages from the list at the left side of the page.
The Information Pages page is displayed.

4 Click Printer Settings.
The Printer Settings page is printed.
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Printer Settings
You can select menu items and corresponding values from the Printer Setting Utility.
The following procedure uses Windows XP as an example.

NOTE: 
• Factory defaults may vary for different countries.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.
Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Select the desired value, and then click the associated button with each menu item.
Driver settings may have precedence over changes previously made and may require you to 
change the Printer Setting Utility defaults.
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6
Using the Operator Panel

This chapter includes:
• "Resetting to Factory Defaults" on page 102
• "Understanding the Operator Panel Lights" on page 103
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Resetting to Factory Defaults
After Initializing the Non-Volatile Memory (NVM) and rebooting the printer, all the menu parameters or 
data are reset to their factory default values.

1 Turn off the printer.

2 Open the rear door.

3 While holding down the  (Start) button and the  (Cancel Job) button at the same time, turn 
on the printer.

4 After the  (Start),  (Energy Saver), and  (Error) indicators go out, release the  (Start) 
button and  (Cancel Job) button.

5 Close the rear door.
The printer starts initializing the NVM.

IMPORTANT: 
• Never attempt to turn off the printer. The printer will cease to function.
The printer restarts automatically to apply the settings and prints the Printer Settings and Panel 
Settings pages.

6 Check if the factory settings are restored by referring to the Printer Settings and Panel Settings 
pages.
Using the Operator Panel 102



Understanding the Operator Panel Lights
The operator panel lights mean different things, depending on their sequence. Orange or green lights 
that are off, on, and/or blinking indicate printer conditions such as printer status, intervention (for 
example, out of paper), or service.

Off On Blink
—

—

KC
YM

1

2
3

4

5

6
7
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Common Light Sequences
The following table shows the most common light status.

1 2 3 4 5 6 7 Printer Status
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

Data
— — — — — — Ready

— — — — — — Processing

— — — — — — Printing

— — — — — Canceling

— — — — — — Calibrating

— — — — — — Warming up

— — — — — — Waiting for incoming data

— — — — — — Initializing NVM

— — — — — — On Diagnosis when starting

— — — — — — In Power Saver Mode

— — — — — Waiting for manual duplex 
printing. *1

*1 Load paper for the second side (odd) pages, and press the  (Start) button. See "Manual Duplex 
Printing (Windows Print Driver Only)" on page 84.
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Warnings
The following table shows the warning conditions. You can continue printing even though the warning 
appears.

1 2 3 4 5 6 7 Printer Status
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

DataY M C K
— — — — — — *1 — *2 The yellow toner is 

low.*3

— — — — — — *1 — *2 The magenta toner is 
low.*3

— — — — — — *1 — *2 The cyan toner is 
low.*3

— — — — — — *1 — *2 The black toner is 
low.*3

— — — — — *2 The printer is in the 
Non Genuine Toner 
mode.

— — — — — — — — *2 The yellow toner is 
empty.*4

— — — — — — — — *2 The magenta toner is 
empty.*4

— — — — — — — — *2 The cyan toner is 
empty.*4

*1 When another error occurs,  (Error) indicator lights up and the toner indicators do not light up.
*2 The  (Ready/Data) indicator blinks or lights up green depending on the printer status.
*3 This warning appears only when Fuji Xerox toner cartridges are used (Non Genuine Toner is set to off at 

the Printer Setting Utility).
*4 In this case, you can continue printing in black and white.
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Operator Call Errors
The following table shows the location where an error occurred. Operator call errors require some kind 
of intervention to resolve the problem.

1 2 3 4 5 6 7 Cause/Remedy
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

DataY M C K
— — — — — — — No paper is loaded.

Load paper and press 
the  (Start) 
button.
See "Loading Print 
Media" on page 72.

— — — — — — — — Paper jam occurred.
See "Clearing Jams" 
on page 112.

— — — — — — — — — The rear door is 
open.
Close the rear door.

— — — — — — — The wrong size of 
paper is loaded. 
See "Loading Print 
Media" on page 72.

— — — — — — — — — An error occurred.
Press and hold the 

 (Start) button to 
display the secondary 
error light sequences.

— — — — — — — — The specified toner 
cartridge is not 
installed or not 
installed correctly. 
Re-install the 
specified toner 
cartridge.
See "Installing a 
Toner Cartridge" on 
page 164.

— — — — — — — —

— — — — — — — —

— — — — — — — —

— — — — — — — — The specified toner 
cartridge is empty or 
invalid. Replace the 
specified toner 
cartridge.
See "Replacing Toner 
Cartridges" on 
page 161.

— — — — — — — —

— — — — — — — —

— — — — — — — —

— — — — — — — — The density of the 
specified toner is not 
enough. Replace the 
specified toner 
cartridge.
See "Replacing Toner 
Cartridges" on 
page 161.

— — — — — — — —

— — — — — — — —

— — — — — — — —
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Secondary light sequences
When the  (Error) indicator lights up, a secondary error has occurred. Press and hold the  (Start) 
button to display the secondary error light sequences.

1 2 3 4 5 6 7 Cause/Remedy
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

DataY M C K
— — — — — — Memory overflow

Press the  
(Cancel Job) button 
to clear the message 
and cancel the 
current print job.
See "Canceling a 
Print Job" on 
page 90.

— — — — — — Page Description 
Language (PDL) 
error
Press the  
(Cancel Job) button 
to clear the message 
and cancel the 
current print job.
See "Canceling a 
Print Job" on 
page 90.

— — — — — — Invalid job 
environment
The configuration of 
the printer set on the 
print driver does not 
match the 
configuration of your 
printer.
Press the  
(Cancel Job) button 
to cancel the current 
print job.
See "Canceling a 
Print Job" on 
page 90.

— — — — — — Color Toner Density 
(CTD) sensor 
dustiness
Clean the CTD 
sensor.
See "Cleaning the 
Color Toner Density 
(CTD) Sensor" on 
page 160.
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Fatal Errors
Contact the Fuji Xerox local representative office or an authorised dealer if this error occurs 
repeatedly.

See also: 
• "Online Services" on page 181

1 2 3 4 5 6 7 Cause/Remedy
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

Data
— — — — — — A fatal error occurred.

Turn off the printer, and 
then on.
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Firmware Errors
Contact the Fuji Xerox local representative office or an authorised dealer if this error occurs 
repeatedly.

See also: 
• "Online Services" on page 181

1 2 3 4 5 6 7 Cause/Remedy
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready/

DataY M C K
— — — — — — — A firmware error 

occurred.
Press the  
(Cancel Job) button 
to clear the error. 
See "Canceling a 
Print Job" on 
page 90.

— — — — — — A ROM erasing error 
occurred.
Turn off the printer, 
and then on.

— — — — — A ROM writing error 
occurred.
Turn off the printer, 
and then on.

— — — — An error occurred 
while downloading 
the firmware.
Turn off the printer, 
and then on.
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7
Troubleshooting

This chapter includes:
• "Clearing Jams" on page 112
• "Basic Printer Problems" on page 121
• "Display Problems" on page 122
• "Printing Problems" on page 123
• "Print Quality Problems" on page 124
• "Adjusting Color Registration" on page 141
• "Noise" on page 146
• "Other Problems" on page 147
• "Contacting Service" on page 148
• "Getting Help" on page 149
• "Non Genuine Toner Mode" on page 153
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Clearing Jams
This section includes:

• "Avoiding Jams" on page 113
• "Identifying the Location of Paper Jams" on page 114
• "Clearing Paper Jams From the Front of the Printer" on page 115
• "Clearing Paper Jams From the Back of the Printer" on page 116
• "Clearing Paper Jams From the Center Output Tray" on page 118
• "Jam Problems" on page 120

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 64
• "Supported Print Media" on page 68

NOTE: 
• Before buying large quantities of any print media, it is recommended that you try a sample first.
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Avoiding Jams
• Use only recommended print media.
• See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 75 to load print media 

properly.
• Do not overload the print media sources. Ensure that the stacked print media does not exceed 

the maximum height indicated on the paper width guides.
• Do not load wrinkled, creased, damp, or curled print media.
• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 

feeding one sheet at a time through the MPF.
• Do not use print media that you have cut or trimmed.
• Do not mix print media sizes, weights, or types in the same print media source.
• Ensure that the recommended print side is face up when you insert the print media.
• Keep print media stored in an acceptable environment.
• Ensure that all cables that connect to the printer are correctly attached.
• Overtightening the guides may cause jams.

See also: 
• "About Print Media" on page 64 
• "Supported Print Media" on page 68
• "Print Media Storage Guidelines" on page 67
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Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:
• Do not attempt to remove a paper jammed deeply inside the product, particularly a paper wrapped 

around a Fusing Unit or a heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product promptly and contact your local Fuji Xerox representative.

1 Center Output Tray

2 Transfer Belt

3 Levers

4 Rear Door

5 Front Cover

6 Multipurpose feeder (MPF)

1 2 3

4

56
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Clearing Paper Jams From the Front of the Printer
NOTE: 
• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Pull the paper cover out.

2 Remove any paper jammed from the front of the printer.

3 Replace the paper cover in the printer.

IMPORTANT: 
• Do not use excessive force on the paper cover. Doing so could damage it or the inside of the printer.
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Clearing Paper Jams From the Back of the Printer
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear door.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer.
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4 Lower the levers to their original position.

5 Close the rear door.
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Clearing Paper Jams From the Center Output Tray
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear door.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer. If no paper is found in the paper path, 
then remove any paper jammed out of the center output tray.
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4 Lower the levers to their original position.

5 Close the rear door.
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Jam Problems
This section includes:

• "Misfeed jam" on page 120
• "Multi-feed jam" on page 120

Misfeed jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Multi-feed jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Print media misfeeds occur. Ensure that the paper is properly inserted in the MPF.

Depending on the print media you use, take any of the following 
actions:
• For thick paper, use the one that is 216 gsm or less.
• For thin paper, use the one that is 60 gsm or more.
• For the envelope, ensure that it is properly loaded in the MPF as 

instructed in "Loading Envelope in the Multipurpose Feeder 
(MPF)" on page 79.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex printing, ensure that the print media is 
not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action
Print media multiple feeds occur. Ensure that the paper is inserted properly in the MPF.

If the print media is damp, use print media that is not damp.

Fan the print media. 
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Basic Printer Problems
Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the 
following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.
• The printer is turned on.
• The electrical outlet is not turned off at any switch or breaker.
• Other electrical equipment plugged into the outlet is working.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.
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Display Problems

Problem Action
After the printer is turned on, the 

 (Ready/Data) indicator is not 
lit.

Turn off the printer, wait for 10 seconds, and turn on the printer.
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Printing Problems

Problem Action
Job did not print or incorrect 
characters printed.

Ensure that the  (Ready/Data) indicator is lit.

Ensure that print media is loaded in the printer.

Verify that you are using the correct print driver.

Ensure that you are using the correct USB cable and that it is 
securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for 
your printer. 

See also: 
• "Usable Print Media" on page 69

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the paper width guides and length guide are adjusted 
correctly.

Do not overfill the print media sources.

Do not force print media into the MPF when you load it.

Otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Load the recommended print side correctly for the type of print media 
you are using.

See also: 
• "Loading Print Media" on page 72

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load a print media source only when it is empty.

The envelope is creased after 
printing.

Ensure that the envelope is loaded as instructed in "Loading 
Envelope in the Multipurpose Feeder (MPF)" on page 79.

Page breaks in unexpected 
places.

Increase the value for Job Time-Out in the System Settings menu, 
that is on the Printer Maintenance tab in the Printer Setting Utility.

Print media does not stack neatly 
in the center output tray.

Turn the print media stack over in the MPF.

Job prints from the wrong source 
or on the wrong print media.

Check Paper Type in the print driver.
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 125
• "Toner Smears or Print Comes Off/Stain on Back Side" on page 126
• "Random Spots/Blurred Images" on page 127
• "The Entire Output Is Blank" on page 128
• "Streaks Appear on the Output" on page 129
• "Pitched Color Dots" on page 130
• "Vertical Blanks" on page 131
• "Mottle" on page 132
• "Ghosting" on page 133
• "Fog" on page 134
• "Bead-Carry-Out (BCO)" on page 135
• "Auger Mark" on page 136
• "Wrinkled/Stained Paper" on page 137
• "The Top Margin Is Incorrect" on page 138
• "Color Registration Is out of Alignment" on page 139
• "Protrudent/Bumpy Paper" on page 140

NOTE: 
• In this section, some procedures use the Printer Setting Utility or SimpleMonitor. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 45
• "SimpleMonitor (Windows Only)" on page 46
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The Output Is Too Light

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The output is too light. The toner cartridges may be low or need to be replaced. Confirm the 

amount of toner in each toner cartridge. 
1 Check the toner level in the Status tab in the Status Monitor 

window.
2 Replace the toner cartridges as necessary.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 69

Try changing the Paper Type setting in the print driver.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Disable Draft Mode in the print driver.
1 On the Advanced Settings tab in Printing Preferences of the 

print driver, ensure that the Draft Mode check box is not selected.
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Toner smears or print comes off.
The output has stain on the back 
side.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 69

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.
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Random Spots/Blurred Images

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has random 
spots or is blurred.

Ensure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 164

If you use non-genuine brand toner cartridges, install genuine brand 
toner cartridges.

Clean up the fusing unit.
1 Load one sheet of paper on the MPF, and then print a solid image 

all over paper.
2 Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.
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The Entire Output Is Blank

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
Troubleshooting 128



Streaks Appear on the Output

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
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Pitched Color Dots

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
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Vertical Blanks

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has vertical 
blanks.

Clean inside the printer and perform test print.
1 Clean inside the printer by using the print head cleaning rod. 
2 Click Print Test Page in the Properties window of the print driver.

See also: 
• "Cleaning Inside the Printer" on page 157
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Mottle

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has mottled 
appearance.

Adjust the transfer bias.
1 Launch the Printer Setting Utility, click Adjust BTR on the Printer 

Maintenance tab.
2 Adjust the setting for the type of print media being used.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Ghosting

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has ghosting. Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Chart Print on the 
Diagnosis tab.

2 Click the Ghost Configuration Chart button.
The Ghost Configuration Chart is printed.

3 Click BTR Refresh Mode on the Printer Maintenance tab.
4 Select the check box next to On, and then click the Apply New 

Settings button.
5 Click Chart Print on the Diagnosis tab.
6 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Fog

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result is foggy. When the whole is printed light, contact the Fuji Xerox local 

representative office or an authorised dealer.

When the printed page is partly light, start Developer Stir Mode.
1 Launch the Printer Setting Utility, and click Developer Stir Mode 

on the Diagnosis tab.
2 Click the Start button.
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Bead-Carry-Out (BCO)

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Bead-Carry-Out (BCO) is 
happening.

If the printer is installed in a high altitude location, set the altitude of 
the location.
1 Launch the Printer Setting Utility, and click Adjust Altitude on the 

Printer Maintenance tab.
2 Select the value close to the altitude of the location where the 

printer is installed.
3 Click the Apply New Settings button.
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Auger Mark

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has auger 
mark.

The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge.
1 Check the toner level in the Status tab in the Status Monitor 

window.
2 Replace the toner cartridges as necessary.

Start Developer Stir Mode.
1 Launch the Printer Setting Utility, and click Developer Stir Mode 

on the Diagnosis tab.
2 Click the Start button.
Troubleshooting 136



Wrinkled/Stained Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 69
• "About Print Media" on page 64

If you use the envelope, check whether the crease is within 30 mm of 
the four edges of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is 
considered normal. Your printer is not at fault.

If not, take the following actions:
• If the envelope is #10 envelope, which is 220 mm or longer and 

has a flap on the long edge, use a different size envelope.
• If the envelope is C5, which is 220 mm or longer and has a flap on 

the short edge, load it in the MPF with the flap open and facing up.
• If the envelope is Monarch or DL, which is shorter than 220 mm, 

load it long edge feed in the MPF with the flap open and facing up.
If the problem continues, use a different size envelope.
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The Top Margin Is Incorrect

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The top margin is incorrect. Ensure that the margins are set correctly on the application being 

used.
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Color Registration Is out of Alignment

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Color registration is out of 
alignment.

Execute auto color registration adjustment.
1 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
2 Deselect the check box next to On.
3 Click the Start button next to Auto Correct.

Clean the CTD sensor.
1 Clean the CTD sensor. 
2 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
3 Deselect the check box next to On.
4 Click the Start button next to Auto Correct.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 160

Print the color registration chart and manually correct the color 
registration. 
1 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
2 Deselect the check box next to On.
3 Click the Start button next to Print Color Regi Chart.
4 Select the paper size, and then click OK.

The color registration chart is printed.
5 Check the values with the straight lines on the chart.
6 Select the value for each color on the Printer Setting Utility.
7 Click the Apply New Settings button.
8 Click the Start button next to Print Color Regi Chart to print the 

color registration chart again.
9 Adjust till all straight lines are at the value of 0.

See also: 
• "Adjusting Color Registration" on page 141
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Protrudent/Bumpy Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.
1 Load one sheet of paper on the MPF, and then print a solid image 

all over paper.
2 Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.
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Adjusting Color Registration
This section describes how to adjust the color registration when you first install the printer or after 
moving it to a new location.
This section includes:

• "Performing Auto Correct" on page 142
• "Printing the Color Registration Chart" on page 143
• "Determining Values" on page 144
• "Entering Values" on page 145
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Performing Auto Correct
Auto Correct allows you to correct the color registration automatically.

The Printer Setting Utility
The following procedure uses Microsoft® Windows® XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Auto Correct.
The color registration is corrected automatically.
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Printing the Color Registration Chart

The Printer Setting Utility
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Print Color Regi Chart.

6 Select the paper size, and then click OK.
The color registration chart is printed.
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Determining Values
On the color registration chart printed, find the straightest lines where the two black lines and the 
colored line are most closely aligned for each color (Y, M, and C).
If you find the straightest line, make a note of the value (-5 – +5) indicated by the straightest line for 
each color.
When the value is 0 for each color, you do not need to adjust the color registration.
When the value is not 0, enter the value according to the procedure in "Entering Values" on page 145.
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Entering Values

The Printer Setting Utility
Using the Printer Setting Utility, enter the values that you found in the color registration chart to make 
adjustments. 
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Select the value you checked in the color registration chart, and then click the Apply New 
Settings button.

6 Click the Start button next to Print Color Regi Chart.

7 Select the paper size, and then click OK.
The color registration chart is printed with the new values.

8 Adjust until all straight lines are at the value of 0. Show image of before and after adjustment will 
help.

IMPORTANT: 
• After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 
• If 0 is not next to the straightest lines, determine the values and adjust the printer again. 
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Noise
NOTE: 
• In this section, the procedures use the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 45

Problem Action
The printer makes a strange 
noise.

Locate the cause of the problem by removing the toner cartridges.
1 Remove the toner cartridges. 
2 Launch the Printer Setting Utility, and click Machine Check on the 

Diagnosis tab.
3 Select Main Motor Operation Check from the drop-down list box, 

and click the Start button.
4 Click the Play of Sound button to check the motor sound.

See also: 
• "Replacing Toner Cartridges" on page 161

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.

Perform Dispense Motor Check.
1 Ensure that the toner cartridges are removed. 
2 Launch the Printer Setting Utility, and click Machine Check on the 

Diagnosis tab.
3 Select Dispense Motor Check(Yellow), Dispense Motor 

Check(Magenta), Dispense Motor Check(Cyan), or Dispense 
Motor Check(Black) from the drop-down list box, and click the 
Start button.

4 Click the Play of Sound button to check the motor sound.
5 Repeat steps 3 and 4 to perform Dispense Motor Check for the rest 

of the toner cartridges.

NOTE: 
• You can perform Dispense Motor Check for CMYK in any order 

you desire.
• Do not check the operation of the dispense motor repeatedly.

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.

Reinstall the toner cartridges and perform Dispense Motor Check.

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Other Problems

Problem Action
Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the 
indicator status on the operator panel.
You need to know the model of your printer and serial number. See the label on the rear door of your 
printer.
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Getting Help
This section includes:

• "Operator Panel Lights" on page 150
• "SimpleMonitor Alerts" on page 151
• "Obtaining the Product Information" on page 152

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.
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Operator Panel Lights
The operator panel provides you with information on errors and warnings. When an error or warning 
condition occurs, the operator panel indicators inform you of the problem. 

See also: 
• "Understanding the Operator Panel Lights" on page 103
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SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks 
the printer status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

NOTE: 
• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced Settings tab and then 
click About.

2 Click Fuji Xerox Web Site. 
Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 
• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/
• For the latest information about the print driver features, refer to the online Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.
The latest firmware and updating tool can be downloaded from the following URL.
Follow the instructions on the web site and download the correct firmware update.
http://www.fujixeroxprinters.com/

NOTE: 
• The communication fee shall be borne by users.
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Non Genuine Toner Mode
When toner within a toner cartridge is empty, a toner indicator lights up or blinks, and at the same 
time, the  (Error) indicator lights up depending on the printer status. For details on indicators, refer to 
"Understanding the Operator Panel Lights" on page 103.
When you want to use the printer in the Non Genuine Toner mode, enable the Non Genuine Toner 
mode and replace the toner cartridge.

IMPORTANT: 
• If you use the printer in the Non Genuine Toner mode, the performance of the printer may not be at its 

optimum. And any problems that may arise from the use of the Non Genuine Toner mode are not covered by 
our quality guarantee. The continuous use of the Non Genuine Toner mode can also cause the printer to 
break down, and any repair charges for such break down will be incurred by users.

NOTE: 
• To disable the Non Genuine Toner mode, deselect the check box next to On on the Non Genuine Toner page 

on the Printer Setting Utility.

This section includes:
• "The Printer Setting Utility" on page 154
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The Printer Setting Utility
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Non Genuine Toner from the list at the left side of the page.
The Non Genuine Toner page is displayed.

4 Select the check box next to On, and then click the Apply New Settings button.
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8
Maintenance

This chapter includes:
• "Cleaning the Printer" on page 156
• "Replacing Toner Cartridges" on page 161
• "Ordering Supplies" on page 166
• "Storing Consumables" on page 170
• "Managing the Printer" on page 171
• "Conserving Supplies" on page 173
• "Checking Page Counts (Windows Only)" on page 174
• "Moving the Printer" on page 175
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Cleaning the Printer
This section describes how to clean the printer in order to maintain it in good condition and print clean 
printouts all the time.

This section includes:
• "Cleaning Inside the Printer" on page 157
• "Cleaning the Color Toner Density (CTD) Sensor" on page 160

WARNING:
• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 

materials may result in poor performance of the product. Never use aerosol cleaners, or it may catch 
fire and cause explosion.

CAUTION:
• When cleaning this product, always switch off and unplug it. Access to a live machine interior may 

cause electric shock.
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Cleaning Inside the Printer
1 Turn off the printer.

2 Open the toner access cover.

3 Pinch the toner cartridge firmly as shown in the illustration.

4 Pull the toner cartridge out.

IMPORTANT: 
• Always pull the toner cartridge out slowly so you do not spill any toner. 

5 Pull the other three toner cartridges out as well.

6 Pull the print head cleaning rod out.
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7 Insert the print head cleaning rod fully into the hole beside the arrow on the printer until its tip 
reaches the interior of the printer as illustrated below, and then pull it out.

8 Repeat the same procedure for the other three holes.

9 Return the print head cleaning rod to its original location.

10 Replace the black toner cartridge by adjusting it to the associated cartridge holder, and then 
insert it firmly by pressing near the center of the label until the toner cartridge clicks.
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11 Replace the other three toner cartridges as well.

12 Close the toner access cover.
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Cleaning the Color Toner Density (CTD) Sensor
Clean the CTD sensor only when an alert for the CTD sensor is shown on the Status Monitor window 
or operator panel.

1 Ensure that the printer is turned off.

2 Push the rear cover handle and open the rear door.

3 Clean the CTD sensor inside the printer with a clean dry cotton swab.

4 Close the rear door.
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Replacing Toner Cartridges
Fuji Xerox toner cartridges are available only through Fuji Xerox.
It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using accessories, parts, or components not 
supplied by Fuji Xerox.

IMPORTANT: 
• Do not shake the used toner cartridge to avoid spilling of the toner.
• Be sure to use the starter toner cartridge shipped with the printer until it gets empty, and then replace it with a 

purchased one.

This section includes:
• "Overview" on page 162
• "Removing the Toner Cartridges" on page 163
• "Installing a Toner Cartridge" on page 164

WARNING:
• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:
• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it out, 

rinse mouth with water, drink water and consult a physician immediately.
• When replacing toner cartridges, be careful not to spill the toner. In case of any toner spills, avoid 

contact with clothes, skin, eyes and mouth as well as inhalation.
• If toner spills onto your skin or clothing, wash it off with soap and water. 

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).
When a toner cartridge reaches its usable life-span, the operator panel lights blink on and off. The 
following table shows the warning conditions.

IMPORTANT: 
• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 

cartridge to catch any toner that may spill.
• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.
• Do not shake or pound the used toner cartridges. The remaining toner may spill.
• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Indicator Printer Status Action
Toner Energy 

Saver
Jam Start Error Load 

Paper
Ready
/DataY M C K

— — — — — — — — *1 The specified 
toner cartridge is 
low.*2

The toner cartridge 
has become low. 
Prepare a new one.— — — — — — — — *1

— — — — — — — — *1

— — — — — — — — *1

— — — — — — — — *1 The specified 
toner cartridge is 
empty.*3

The toner cartridge 
has become empty. 
Replace the old 
toner cartridge with 
a new one.

— — — — — — — — *1

— — — — — — — — *1

*1 The  (Ready/Data) indicator blinks or lights up green depending on the printer status.
*2 This warning appears only when Fuji Xerox toner cartridges are used (Non Genuine Toner is set to off at 

the Printer Setting Utility.)
*3 In this case, you can continue printing in black and white.
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Removing the Toner Cartridges
1 Turn off the printer.

2 Open the toner access cover.

3 Spread a few sheets of paper on the floor or table where the removed toner cartridge is placed.

4 Pinch the toner cartridge firmly as shown in the illustration.

5 Pull the toner cartridge out.

IMPORTANT: 
• Always pull the toner cartridge out slowly so you do not spill any toner. 

6 Place the toner cartridge slowly on the sheets of paper spread in step 3.
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Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the 

toner evenly.

NOTE: 
• Ensure that the color of the new toner cartridge matches that on the handle before replacing it.
• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Remove the tape from the toner cartridge.

3 Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing 
near the center of the label until the toner cartridge clicks.

4 Close the toner access cover.
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5 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

6 Take care not to contact with the spilled toner and remove the sheets of paper spread under the 
removed toner cartridge.
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Ordering Supplies
This section includes:

• "Consumables" on page 167
• "When to Order Toner Cartridges" on page 168
• "Recycling Supplies" on page 169

The toner cartridges need to be ordered occasionally. Each toner cartridge includes installation 
instructions on the box.
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Consumables
IMPORTANT: 
• Use of consumables not recommended by Fuji Xerox can impair machine quality and performance. Use only 

consumables recommended by Fuji Xerox.

IMPORTANT: 
• The printable number of pages are applicable when A4 paper SEF ( ) is used and printing is done 

continuously at a density such that each toner covers 5% of the page. These values are estimates and vary 
depending on conditions such as the content being printed, paper size, paper type, the machine’s operating 
environment, initializing process done when you turn on or off the printer, and adjustments to maintain print 
quality.

NOTE: 
• The printable number of pages for the starter toner cartridges shipped with the printer are approximately 1000 

pages for black toner cartridge and 700 pages for yellow, magenta, and cyan toner cartridges.
• Each toner cartridge includes installation instructions on the box.

Product Name Product Code Printable number of pages
Toner Cartridge [Black] CT201591 Approx. 2000 pages

Toner Cartridge [Yellow] CT201594 Approx. 1400 pages

Toner Cartridge [Magenta] CT201593 Approx. 1400 pages

Toner Cartridge [Cyan] CT201592 Approx. 1400 pages
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When to Order Toner Cartridges
The operator panel indicators inform a warning when the toner cartridge nears its replacement time. 
Verify that you have replacements on hand. It is important to order a toner cartridge when the 
indicators lighting up which inform you to replace the toner cartridge first appear to avoid interruptions 
to your printing.
To order toner cartridges, contact the Fuji Xerox local representative office or an authorized dealer.

IMPORTANT: 
• This printer is designed to provide the most stable performance and print quality when used with the 

recommended toner cartridges. Not using toner cartridges recommended for this machine degrades the 
performance and printing quality of the printer. You could also incur charges if the machine breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use recommended 
toner cartridges.
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Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 

containers. Return them to your local Fuji Xerox representative.
• To recover scarce resources, rechargeable batteries used in the returned machines are recycled 

as materials or reused for energy generation.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 40 °C (140 °F).
• An environment with extreme changes in humidity or temperature.
• Direct sunlight.
• Dusty places.
• A car for a long period of time.
• An environment where corrosive gases are present.
• An environment with salty air.
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Managing the Printer
This section includes:

• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 172
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Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the 
printer status when you send a print job. SimpleMonitor can also check the remaining amount of toner 
cartridges.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.
If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the start menu.
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click the name of the desired printer from the list.
The Status Monitor window appears.

For details about the functions of SimpleMonitor, refer to the online Help.
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Conserving Supplies
You can change a setting in your print driver to conserve paper.

Supply Setting Function
Print media Multiple-Up in the Layout 

tab of the print driver
The printer prints two or more pages on one side of a 
sheet. The available numbers that each print driver can 
print one sheet of paper are as follows:
• Microsoft Windows Print Driver: 2, 4, 8, 16, or 32 

pages
• Mac OS® X Print Driver: 2, 4, 6, 9 or 16 pages

Combined with the duplex setting, Multiple-Up allows 
you to print up to 64 pages on one sheet of paper. (32 
images on the front and 32 on the back)
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Checking Page Counts (Windows Only)
The total number of printed pages can be checked at the Printer Setting Utility. Four meters are 
available:

The Meter Reading counts the number of pages printed properly. Single side color print (including 
Multiple-Up) is counted as one job, and 2-sided print (including Multiple-Up) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one.
When printing color data, which has been converted by using ICC profile on an application, with the 
Color setting, the data is printed by color even if it seems to be black and white data on the monitor. In 
that case, Meter 1 and Meter 4 are increased.
When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of 
the application. In this case, the blank page is counted as one page. However, when doing 2-sided 
printing for odd number of pages, the blank page inserted to the rear side of the last odd page is not 
counted.
The following procedure uses Windows XP as an example.
To check a meter at the Printer Setting Utility:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP105 b → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Menu Settings from the list at the left side of the page.
The Menu Settings page is displayed.

4 Check the values for each meter under Meter Reading.

Meter 1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3 Displays the total number of large size color prints. 

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + 
Meter 2).
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Moving the Printer
NOTE: 
• The front side of this printer is heavier than the rear. Take note of this difference in weight when moving the 

printer.

1 Turn off the printer.

2 Disconnect the power cord and USB cable.

3 Remove any paper in the center output tray if there is. Close the output tray extension if it is 
opened.

4 Remove any paper in the multipurpose feeder (MPF). Keep the paper wrapped and away from 
humidity and dirt.
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5 Push the paper cover in.

6 Slide the slide bar backward until it stops.

7 Close the front cover.
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8 Lift the printer and move it gently.

NOTE: 
• If the printer is to be moved over a long distance, the toner cartridges should be removed to prevent toner 

from spilling and the printer should be packed inside a box.

9 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 141
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9
Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 180
• "Online Services" on page 181
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and email support. If unsuccessful, to obtain service 
under product warranty the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of Fuji Xerox supplied products, replacement of customer replaceable units, clearing 
paper misfeeds and cleaning the unit and other prescribed routine and preventative maintenance.
If the Customer’s product contains features that enable Fuji Xerox or its authorized service 
representative to diagnose and repair problems with the product remotely, Fuji Xerox may request that 
the Customer allow such remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our website at http://www.fujixerox.com/support/docuprint/
Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/
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